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Introductions

• John Smith, Senior Consultant
> Over 7 years supporting hi-tech companies in implementing and 

managing licensing
> Extensive experience Designing, Implementing and Managing 

Vendor License Management systems and processes

• Michael Albrecht, Practice Director
> Over 10 years in strategy and implementation work focused on 

assisting Software companies implement and integrate Licensing
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Session Objectives

• Discuss how effective License Management can:
> Reduce Software Ownership Costs
> Provide a Competitive Advantage
> Ensure Effective Compliance

• Present and discuss recent innovations in License 
Management

• Provide a practical, structured approach to implementing 
and managing a License Management Program
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Background and Industry Trends
Software has become 
increasingly critical to 

the success of 
technology companies

• In some markets, 
software costs are 2nd 
only to salaries

• Design Software is now 
a critical component of 
developing any 
technology product

• Commercial software 
has replaced 
homegrown solutions in 
all but niche markets

• Minimizing costs through 
effective management is 
the most obvious

• Improving design staff 
productivity through 
effective deployment of 
software assets is also 
critical

• Usage data and buying 
power can be leveraged 
to maintain access to 
latest technologies

• Headcount is no longer the 
full picture – Maximizing 
software Utilization per 
Headcount is more critical

• Managing Multiple Vendors 
and Technologies is a 
Reality – There is no “one 
stop shop”

• Any tracking and usage 
solution must be technology 
agnostic – While a specific 
Vendor may have an 
excellent tracking system, it 
won’t apply to other Vendors

Ensuring market success 
requires effective 

adoption and 
management of software 

assets

Consolidation requires a 
flexible approach to 
integrating multiple 

technologies
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Common Pain Points by Role
• pressure to reduce infrastructure costs
• constantly rising software costs, maintenance and support
• Audit exposure and compliance violation risk
• Successfully addressing software aspects of M&A activity
• competitive advantage (are we getting what we need from 

software?)

CEO/
CFO

LOB
Manager

VP of
Procurement

• too many unused tools / old technologies
• not enough new (expensive) tools
• tools in wrong place / not accessible by the right people
• not enough info (costs, who uses what?)
• no metrics
• denials, waits, queuing for tools
• productivity (TTM) impact

• complex contracts – licensing options, license models,
• insufficient information 
• awful lot of stuff (A vendors * B tools * C server * D quantity * E 

remixes)
• unable to take advantage of contract options due to lack of information
• unable to negotiate effectively due to lack of information
• multiple contract with same vendors (M&A)
• rogue purchases not getting appropriate discounts
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LM Opportunities and Benefits

• Centralization of licenses to ensure higher utilization
• Leverage buying power of actual usage to drive discounting
• Negotiate actual “value” of licenses based on impact to busy
• Leverage re-mix capability to minimize new purchases

• Ensure Engineers have access to the tools they need 
• Manage Denials of Service based on cost to business
• Identify internal best practices through software usage data

• Use Chargeback and Allocations to drive productive behavior
• 1 License per Resource may be sub-optimal – Lengthy 

compilation tasks may enable multitasking
• Correct poor Design practices through aberrant usage data

• Best defense is a thorough offense – Once Vendors realize you 
are managing usage, Audit costs outweigh benefits

• Simply communicating existing of LM may forestall Audits
• Reverse Audits – Actual usage data may drive cost savings

Focus
Area

Estimated
Impact Key Principles

Cost Savings

Time to Market

Productivity

Compliance

30-40% of 
Annual Spend

5-15%
Reduction

10-20%
Increase

50-75% Effort
Reduction
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Hierarchy Matrix – Where are You?

Purchasing
Organization

Vendor
Contracts

License
Sharing

Usage
Tracking

Software
Utilization

• Enterprise

• Division

• Department
/ Work 
Group

• Standard
• Product Pools
• Remix
• Global Visibility
• Add-ons and 

Access Rates

• Occasional
• Buy at Price List
• Some Regional 

Benefits

• None
• Localized 

Purchases
• PO’s and Local 

Approval

• In Contract
• C-Level Sponsor
• Infrastructure 

Support

• Within 
Geography

• Silos still exist

• Work Group 
Level

• No formalization

• Most Vendor and 
Tools

• Formalized Enterprise 
Methodology

• Closed Loop System

• Critical Tools
• Unique to Department 

or Site
• No Standards

• None
• Crisis Mode 

Reaction

50
-8

0%
•2

0-
60

%
•<

25
%
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Hierarchy Matrix – Where are You?

Chargeback Remixing
Software
Portfolio Software

Utilization
Compliance

• Most/All Tools 
Quarterly

• Based on Peak 
Usage

• Automated Reports

• Some Vendors
• Annual Process
• Based on Usage 

Hours
• Manually Generated

• None
• Fixed Charge/ 

Allocation

• All Major Vendors
• Most Critical tools
• High % of Contracts
• Frequent

• Some Vendors
• Infrequent 

Occurrence
• Low % of Contract 

Value

• Mostly Perpetual
• Nodelocked

Licenses
• Significant 

“Shelfware”
• Frequent Sales Calls

• No  Perpetuals
• Pay Per Use
• Highly Flexible 

Deployment 
Environment

• Mixed: Perpetual & 
Time Based

• Some Redundancy
• Limited 

Consolidation

• Node locked
• Many Perpetual
• Significant 

Shelfware

• Enforced
• Vendor is 

Managed to 
Usage

• Some Internal 
Procedures

• Basic Tracking
• Accidental 

Overages

• No Procedures
• Highly Exposed

50
-8

0%
•2

0-
60

%
•<

25
%
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Example Techniques

• License Sharing

• Charge Backs and Allocation

• Remixing

• Competitive Advantage – License Usage
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License Sharing
Typical

Design Group 1
Design:  3 copies

Simulate:  2 copies
Test:  3 copies

Denial of Service: 10%

Design Group 2
Design:  4 copies

Simulate:  5 copies
Test:  4 copies

Denial of Service: 15%

Design Group 3
Design:  3 copies

Simulate:  6 copies
Test:  4 copies

Denial of Service: 5%

• Individual Groups 
Purchase Duplicate 
Software Portfolio

• Low License 
Utilization as most 
Licenses are Idle 
Most of the Time

• Groups Still 
Experience Frequent 
Denial of Services

Design:  10 Copies
Simulate: 13 Copies

Test:  11 Copies

Design Group 1

Denial of Service: 0%

Design Group 2

Denial of Service: 0%

Design Group 3

Denial of Service: 0%

Pool

• By combining 
Licenses across 
Groups, Denial of 
Service can be 
Reduced

• Economies from a 
larger pool

Design:  8 Copies
Simulate: 10 Copies

Test:  7 Copies

Design Group 1

Denial of Service: 5%

Design Group 2

Denial of Service: 5%

Design Group 3

Denial of Service: 5%

Reduce

• By reducing Total 
Licenses Pools, 
Reasonable Denial 
of Services can be 
Achieved while 
Reducing Costs

• DOS in larger Pools 
typically have less 
impact due to 
shorter wait time

Design:  6 Copies
Simulate: 8 Copies

Test:  5 Copies

Design Group 1
Denial of Service: 5%

Design Group 2
Denial of Service: 5%

Design Group 3
Denial of Service: 5%

Time Zone
N. America

Design Group 1
Denial of Service: 5%

Design Group 2
Denial of Service: 5%

Design Group 3
Denial of Service: 5%

APAC

• Expanding Globally, 
Licenses can be 
used across multiple 
organizations, 
ensuring 24x7 
Usage

Design:  6 Copies
Simulate: 8 Copies

Test:  5 Copies

Design Group 1
Denial of Service: 0%

Design Group 2
Denial of Service: 0%

Design Group 3
Denial of Service: 0%

Stagger

• By Staggering 
Design Schedules, 
Denial of Services 
can be Reduced 
while further 
Reducing Total 
Licensing
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Modifying Behavior through Charge Back
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License Pool

10 Copies = $100K

Group 1:
2 Engineers

Group 2:
3 Engineers

Group 3:
5 Engineers

$20K $30K $50K

Poor

• Costs are allocated based on 
simple headcount (or similar)

• Whether a resource uses the 
License, they are still forced to 
fund

• Encourages over-use and drives 
additional purchases

N
ot

es

License Pool
10 Copies = $100K

Usage: 1,000 Hours

Group 1:
2 Engineers
350 Hours

Group 2:
3 Engineers
250 Hours

Group 3:
5 Engineers
400 hours

$35K $25K $40K

Better

• Actual Usage is driving factor in 
allocating costs

• Groups are now billed based on 
actual access, so groups benefit 
from managed use

• Software costs not optimized as 
no benefit to leverage low usage 
periods

License Pool
10 Copies = $100K

1,000 Hours

Peak:  August Usage

Group 1:
2 Engineers
350 Hours

Usage:
60% of Peak

Group 2:
3 Engineers
250 Hours

Usage:
30% of Peak

Group 3:
5 Engineers
400 hours

Usage:
10% of Peak

$60K $30K $10K

Optimized

• Peak usage (the driver of the total 
software costs) are tracked

• Only active users at Peak periods
are billed for software
• Rewards users who access 
licenses at non-peak times
• Can reduce total number of seats 

required, reducing overall costs 
for all groups

License Pool

Unknown

None

Each group 
evaluates, 

acquires and 
uses 

software on 
their own

$?K $?K $?K
• No allocation
• Each group has 

budget and uses it as 
they see fit

• No reason to share 
and no management 
visibility

None
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Remixing Current Usage

Design

10 Seats

Simulation

20 Seats

Test

15 Seats

$400K
DOS:  Frequent

Wait Time: Excessive
Average Usage: 9

Cost:  $15K per Seat

DOS:  None
Wait Time: None

Average Usage: 10
Cost: $5K

DOS:  Minimal
Wait Time: Small

Average Usage: 12
Cost: $10K

Remixed Usage
$400K

Design

14 Seats

DOS:  Minimal
Wait Time: Small
Average Usage: 12
Cost:  $15K per Seat

Simulation
12 Seats

DOS:  Minimal
Wait Time: Small
Average Usage: 10
Cost: $5K

Test

13 Seats

DOS:  Minimal
Wait Time: Small
Average Usage: 11
Cost: $10K

By Remixing, Customer was able to improve Utilization and 
Productivity while maintaining Total Costs
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Develop Competitive Advantages

Group 1

Group 2 Design Phase Simulation Phase Test Phase

Design Phase Simulation Phase Test Phase

• Objective Usage Data can provide insight into business 
performance:

P
ot

en
tia

l F
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ng

s

Results May Vary: Most companies are surprised by the results of the analysis.

E
xa

m
pl

e

Example Findings:
One group of engineers can support complex projects; another is better suited at 
rapidly completing simple project
Although phase is officially “complete” - Usage data indicates otherwise causing 
extension of following phases
May provide insight into the effectiveness of competing products – i.e. one 
Vendor’s Test tool is much more efficient than another’s
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Approach Overview

Contract
Analysis

Engage
IT

Prioritize
Products Monitor Develop

KPIs
Determine
Targets

Negotiate
Contracts

• Provides a repeatable, structured process to:
> Ensure focus is applied to critical (i.e. most costly) expenditures
> Ensure effort is expended where impact can be maximized
> Provide early wins while maintaining consistency across Enterprise
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Contract Analysis – Identify Target Vendor

Contract
Analysis

Engage
IT

Prioritize
Products Monitor Develop

KPIs
Determine
Targets

Negotiate
Contracts

Vendor $
Usage
Mgmt.

Update
Access Remix

Est.
Usage

Acme $10M Individual No No Jan-08 25%

Design $8M Department Yes Yes Jun-08 35%

Test Sys. $6.5M Corporate No No Jan-09 30%

Next
Negotiation

• Engage Procurement to determine key vendors and evaluate relationship
• Identify annual spend on software and agreement terms
• Prioritize based on:

> Impact to Business – How much is being spent now?
> Timeliness – When is next opportunity to negotiate with vendor?
> Flexibility – Can usage data drive real time changes (Per Contract or other?)



Stay ahead of the curveStay ahead of the curve

Engage IT – Identify Additional Seats

Contract
Analysis

Engage
IT

Prioritize
Products Monitor Develop

KPIs
Determine
Targets

Negotiate
Contracts

• Uncover non-standard purchases
> Work with IT and Engineering to identify “rogue” purchases
> Audit internal servers for unknown or unauthorized copies
> Estimate scale as compared to original contracts
> Uncover “shelf ware” situations where active license are not being used

• Begin defining usage communities
> Develop Enterprise map of license users, locations and needs

Contracts and IT should provide a 90% picture of License Usage
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Prioritize Products – High Value/Cost
Contract
Analysis

Engage
IT

Prioritize
Products Monitor Develop

KPIs
Determine
Targets

Negotiate
Contracts

$

A B C D

• Prioritize based 80/20
> 20% of products from vendor are 

responsible for 80% of value to 
business

> Metric:  # of Seats * Per Seat Cost

• Highest ranking should be most 
important tool, if not:

> Reduce Seat Count or 
> Increase availability
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Monitor – Implement Usage Tracking
Contract
Analysis

Engage
IT

Prioritize
Products Monitor Develop

KPIs
Determine
Targets

Negotiate
Contracts

• Leverage existing or implement usage 
tracking tools

• Start Simple (for Consistency):
> Application
> User
> Time in/Time Out

• Verify accuracy of data
• Expand to include business data:

> Project
> Department
> Geography

Logs

design jjones 8-20 7:51 out
sim bthomas 8-20 7:57 out
design jjones 8-20 8:30 in
test jjones 8-20 8:45 out
compile bthomas 8:20 out
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Develop KPIs – Determine Tracking Method

Contract
Analysis

Engage
IT

Prioritize
Products Monitor Develop

KPIs
Determine
Targets

Negotiate
Contracts

• Classify Application Type
> Batch – Transaction based (compilation, 

etc.)
> Interactive – Frequent use transactions

• Define Measurement Approach
> Peak Usage
> License Utilization

• Set Desired Frequency of Denial
> 0% denials is clear sign of excess licenses
> Impact of denial is based on average usage 

time – high denial rate may be acceptable if 
wait is low (i.e. less than 5 minutes)

Total Usage Hours 

# of Seats * Total Hours in period

A

B
D

D
C

100

200

300

B
D

Peak Usage
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Determine Targets – Track Progress

• Example: Denial of Service
> Determine Target DOS (i.e 10%)
> Measure # of Licenses in Use over 

period of time
> Identify License Count that 

supports Target DOS
> Restrict License Availability

• Alternate:  Utilization
> Set Target Utilization %
> Restrict License Availability

Contract
Analysis

Engage
IT

Prioritize
Products Monitor Develop

KPIs
Determine
Targets

Negotiate
Contracts
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Negotiate Contracts – Engage Vendors

• Provide Real Usage Data
> Discuss current Utilization profiles
> Identify oversold products
> Identify growth areas

• Propose “desired” state of usage
> Replace estimated needs

Contract
Analysis

Engage
IT

Prioritize
Products Monitor Develop

KPIs
Determine
Targets

Negotiate
Contracts

• Potential Benefits
> Reduce ongoing costs (license and/or 

maintenance)
> Calculate true value of capability (i.e. 

WAN Licensing)
> Position remix capability, either

• Ongoing (Ideal)
• One Time (as condition of renewal)

> Get access to new technologies in 
place of old shelfware or unused 
capacity
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Implementation – Example Projects
• Strategy Assessment (1-3 Weeks, 1.5 Resources)

> Engage VPs/Directors of impacted organization to evaluate current approach 
> Assess performance in comparison with industry and leading practices
> Develop “Program Vision” to drive awareness internally
> Provide high level implementation approach

• Technology QuickStart (1 Week, 1 Resource)
> Based on internal research, target internal group to pilot License Usage Tracking
> Implement tracking and begin monitoring usage/activity

• Tracking and Reporting (4-6 Weeks, 2 Resources)
> Design and develop reports for effective license management
> Implement integrate tracking and reporting technologies
> Leverage analysis of usage data to begin driving internal behavior

• Enterprise Transformation (TBD Weeks, TBD Resources)
> Follow standard methodology
> Work closely with Procurement, Legal and Lines of Business to identify target Vendors
> Implement technology, track results and drive vendor relationships
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Contact Info
• John Smith

> john.smith@macrovision.com
> (408) 969-5415
> Santa Clara Office

• Online:
> www.macrovision.com


